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Getting Started 
Before you install the IP Attendant and IP Downloader, you need the following 
information and access rights.  

DO NOT PROCEED UNTIL YOU HAVE ALL OF THESE REQUIREMENTS. 

 

Required Information: 

 IP address for IP Downloader which includes the following: 

o DHCP environment (Yes or No) 

o If DHCP environment is No 

 IP address (Note: The factory default IP address is 
192.168.104.104 with a subnet mask of 255.255.255.0) 

 DNS server address 

 Default gateway 

o If DHCP environment is Yes , the IP Downloader will be addressable 

using the network name printed on its label 

 IP Address or computer name of the computer running the IP Attendant 
service 

 IP Attendant workstation has one of the following: 

o GUARD1 PLUS version 2.81 or later 

o Access to the GUARD1 PLUS SE version 4.40 or later server share  

 Is the computer that you are using to remotely access the IP Downloader 
connected in the same LAN/WAN or VPN environment as the IP Downloader 
or is it reachable via the Internet?  

 Are you using a proxy server? If so, what is its IP address? 

 Are the firewall settings on the IP Attendant workstation controlled by Windows 
Firewall settings or by group policy? 

 Is there an Internet firewall between the IP Downloader and the IP Attendant? 

 

Required Rights: 

 If there is a firewall between the IP Downloader and the IP Attendant, you must 
obtain permission to modify the firewall configuration. Optionally you may 
enable communication to the IP Downloader for its remote management. 

 Local Administrator privileges on the computer running the IP Attendant 
Service. 
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Installation Overview – IP Attendant 

Installing IP Attendant  

The IP Attendant is a service which receives download data from an IP Downloader 
over HTTP protocol. For a GUARD1 PLUS installation, when PIPE data is received the IP 
Attendant saves the data to a .DL2 file then alerts the local Attendant to process the 
data into the database. NOTE: the IP Attendant service will run and collect data if the 
PC is not logged on, but the Attendant requires a user to be logged in.  Data will not be 
processed by the Attendant until a user logs in to the PC. 

For a GUARD1 PLUS SE installation, when PIPE data is received the IP Attendant 
commits the download data to the SQL application database. In a GUARD1 PLUS SE 
deployment, we recommend that you install the IP Attendant on a server.  

There are two configuration options for the IP Attendant service: default and custom. 
We recommend that you use the default configuration unless your IT administrator 
requires a custom passphrase or port number.  

Prior to installing the IP Attendant, the workstation must meet these minimum 
requirements: 

 Operating System 

o Windows XP with Service Pack 3 (32 bit only) 

o Microsoft Vista with Service Pack 2 (32 and 64 bit) 

o Microsoft Windows 7 (32 and 64 bit) 

o Server 2003  with Service Pack 2 (32 bit only) 

o Server 2008 with Service Pack 2 (32 and 64 bit) 

o Server 2008 R2 

 GUARD1 PLUS Program 

o GUARD1 PLUS version 2.81 or later 

or 

o Able to access the GUARD1 PLUS SE version 4.40 or later server share  

 Port 50150 must be open on the Internet’s firewall if there is an Internet firewall 
between the IP Downloader and the IP Attendant (to add this port see the 
following section entitled ―Setting your Internet firewall settings‖). 

 Microsoft .NET version 3.5 must be installed. If it is not installed, run setup.exe 
from the ―Microsoft .NET Framework 3.5‖ folder on the IP Attendant CD. You 
can also install it from the web page that automatically appears during the IP 
Attendant’s installation. IP Attendant software will not install until Microsoft 
.NET version 3.5 is installed. 
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Default Configuration: 

A default configuration of the IP Attendant sets these parameters: 

 Event log is enabled 

 Passphrase is set to the system default (blank) 

 Port 50150 is opened on your Windows Firewall  

 The Tks IPAttendant service will run under the local system account 

 The Tks IPAttendant service will launch automatically at startup.  For GUARD1 

PLUS  deployments, the Attendant will also launch automatically at startup. 

 

To install the IP Attendant in the default configuration: 

1. Confirm that you are logged in as the Local Administrator or that you are a 
member of the Local Administrator group. 

2. Insert the IP Attendant CD in the CD drive. The installer will launch 
automatically. 

3. If the installer does not begin automatically, click Start, Run and browse to the 
CD drive. Double-click the setup.exe file. 

4. Click Next at the Welcome screen. 

5. Click Yes at the License Agreement. 

6. Click Finish to complete the installation. After several seconds, the IP 
Attendant Configuration Wizard opens. 
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7. Select Default and click Next. If you have a GUARD1 PLUS SE deployment and 

no SE application is installed on this workstation, the following screen will 
appear otherwise skip to Step 9. 

 

 

8. Enter the required information either by providing the path to the SE server 
share and clicking Retrieve Database Information or by entering the GUARD1 

PLUS SE SQL connection parameters. Click Next to continue. 

 



 5  

 

9. Click Next. 

 

 

10. Click Finish. 

This only appears in an SE 
deployment. 

This only appears in an SE 
deployment. 
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11. Click Exit.  

12. The IP Attendant service is now configured for default operation. 
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Custom Configuration: 

A custom configuration allows you to set a unique passphrase and/or a custom port 
number. 

Both the IP Downloader and the IP Attendant have a passphrase which:: 

 must be the same in order for the IP Attendant to receive the download 
files from the IP Downloader 

 is used to encrypt the download data so the longer the passphrase, the 
more secure the data encryption will be 

The IP Attendant receives download data from an IP Downloader over HTTP protocol 
using default port number 50150. You can specify a different port in a custom 
configuration. All IP Downloaders configured to use this IP Attendant must use the 
same port address to transfer the download data.  

 

To install the IP Attendant using a custom configuration: 

1. Insert the IP Attendant CD in the CD drive. The installer will launch 
automatically. 

2. If the installer does not begin automatically, click Start, Run and browse to the 

CD drive. Double-click the setup.exe file. 

 

 

3. Click Next at the Welcome screen. 

 

4. Click Yes at the License Agreement. 
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5. Click Finish to complete the installation. After several seconds, the IP 
Attendant Configuration Wizard opens. 

 

 

6. Select Custom and click Next. 
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7. Enter your custom passphrase or use the ―Factory Default‖ passphrase and 
click Next. Remember that this passphrase must match the passphrase for 
each IP Downloader that will be using this IP Attendant.  

 

 

8. Select the desired option and click Next. 
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9. Choose either the existing (default) port number of 50150 or specify an 
available port number between 1 and 65535 and click Next. Record this port 
number so that you can confirm that this port is open on your firewall(s). 
 

10.  If you have a GUARD1 PLUS SE deployment and no SE application is 
installed on this workstation, the following screen will appear otherwise skip 
to Step 12. 
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11. Enter the required information either by providing the path to the SE server 
share and clicking Retrieve Database Information or by entering the 
GUARD1 PLUS SE SQL connection parameters. Click Next to continue. 

 

 
12. Click Next. 

 

 

This only appears in an SE 
deployment. 

This only appears in an SE 
deployment. 
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13. Click Finish. 

 

14. Click Exit.  

15. The IP Attendant service is now configured for custom operation. 

 

 

Setting your Internet firewall settings 

If the IP Attendant service receives data from the IP Downloader via the Internet, you 
must configure the perimeter firewall to forward the IP Downloader requests to the IP 
Attendant port (default port is 50150). The protocol is TCP (HTTP). (If the IP Attendant 
was installed with a custom configuration, the port number may be different from 
50150.) 
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Installation Overview – IP Downloader 

Installing IP Downloader 

When a PIPE is docked, the IP Downloader transfers the PIPE’s data to its local 
memory, clears the PIPE, beeps the PIPE and then forwards the data to the IP 
Attendant service on the designated computer. In the case of communication failure, 
the IP Downloader will try resending data every 600 seconds. 

An IP Attendant Service can receive data from multiple IP Downloaders. The IP 
Downloader will be a node in your network environment. To configure the IP 
Downloader in a DHCP environment, you need to know its network name, which is 
printed on the label attached to the bottom of the IP Downloader. To configure the IP 
Downloader in a non-DHCP environment, you need to know its IP address. The default 
IP address is 192.168.104.104.    

Opening the IP Downloader’s Home Page 

To open the IP Downloader’s home page 

1. Connect the Ethernet cable to the IP Downloader. 

2. Connect the Ethernet cable from the IP Downloader to your LAN/WAN/Internet 
port. 

3. Connect the power supply to the IP Downloader.  NOTE: for POE (Power Over 
Ethernet) downloaders, the Ethernet cable supplies power to the downloader. 

4. The IP Downloader may take up to two minutes to acquire its IP address. Wait 
for the Network LED to be solid green. If this LED is not lit, refer to the 
troubleshooting section on page 27. 

5. On a computer connected to the network, open a Web Browser window. 
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6. Refer to the table below to determine the appropriate IP Downloader network 
address to enter in the browser address bar: 

 

Computer‘s Network 
Environment  

Network 
Environment for 
the IP Downloader 

IP Downloader’s Home Page 

Same LAN/WAN/VPN 
as the IP Downloader 

DHCP Enter the IP Downloader’s network 
name in the browser’s address bar.  

The network name begins with ―tks‖ and 
can be found on the label attached to the 
bottom of the IP Downloader. For example:   
http://tks002223390034 

Same LAN/WAN/VPN 
as the IP Downloader 

No DHCP available Enter http://192.168.104.104 in the 
browser’s address bar. 

Note 1: The computer used to configure 
the IP Downloader must have an IP 
address of 192.168.104.xxx  with a subnet 
mask of 255.255.255.0 to be able to open 
the IP Downloader’s home page. 

Note 2: You should modify the factory 
default address upon commissioning to 
avoid any duplicate IP addresses on the 
network. 

A firewall protecting the 
IP Downloader is 
between this computer 
and the IP Downloader 

Not applicable Enter http://xxx.xxx.xxx.xxx:XXXX (the 
firewall’s outer IP address and the port 
exposing the IP Downloader  Management 
Web Server) into the browser’s address 
bar. 

The firewall protecting the IP Downloader 
must be configured to forward inbound 
HTTP requests to the internal IP 
Downloader address on port 50000 in 
order to enable remote management. Ask 
your IT administrator to configure port 
forwarding as described above if remote IP 
Downloader management is required.  If 
you cannot connect to your IP Downloader 
contact your IT administrator. 

 

http://192.168.104.104/
http://xxx.xxx.xxx.xxx/
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Configuring your IP Downloader 

1. From the IP Downloader’s home page, click Manage Downloader. 

2. Enter the password (default password is ―password‖) and click Log in. 

3. Enter the Contact, Location and Time Zone. 

4. For the Server Host Name, enter the computer name or IP Address of the 
computer running the IP Attendant service. (see the section on ―How to 
determine your Computer Name‖) 

5. If DHCP is enabled, do not change the IP address, subnet mask, default 

gateway and DNS server address unless you wish to assign it a static IP 
address.  

6. If DHCP is not enabled, enter the IP Downloader’s new IP address, subnet 
mask, default gateway and DNS server address.  

7. If needed, modify the Server IP Port address. The default port address is 
50150. 

8. If communication to the IP Attendant requires crossing a non-transparent proxy 
server, configure the proxy server URL as follows: 

  http://10.0.0.1:8080 where 10.0.0.1 is the internal proxy server  
  address and 8080 is the HTTP port 

9. Click Apply to save the IP Downloader’s configuration, then click OK. 

10. If you want the default passphrase (recommended), leave the Passphrase and 
Verify Passphrase fields blank. 

11. If you are using a custom passphrase, enter the same passphrase in both 
Passphrase and Verify Passphrase fields and click Set Passphrase. 

12. Once configured, the IP Downloader will connect to the IP Attendant. Upon 
successful communication the IP Downloader’s System and Network LEDs will 
turn green. You can now download a PIPE. 

 

http://10.0.0.1:8080/
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Using the IP Downloader 
 

Downloading the PIPE 

Once configured, the IP Downloader will attempt to communicate with the IP Attendant 
service. Upon successful communication, the IP Downloader’s System and Network 
LEDs will turn green.  

 

How to download a PIPE using an IP Downloader: 

1. Verify that the Network and System LEDs are both green. 

2. Place the PIPE in the downloader. 

3. When you hear the PIPE beep, and/or the Download LED turns green, the 
PIPE has downloaded its data to the IP Downloader.   

4. The PIPE is cleared and you can remove the PIPE from the downloader.  

5. While the IP Downloader is sending the download data to the IP Attendant, the 
System LED is amber. 

6. When the IP Downloader has finished sending the download data to the IP 
Attendant, the System LED is green. 

7. If the LEDs do not show that the download was successful, refer to the 
Troubleshooting section on the next page. 

 

Disconnecting the IP Downloader from the network 

Once the IP Downloader has communicated successfully to the IP Attendant, the IP 
Downloader can download a PIPE even if it is not currently connected to a network or 
system. This is because it stores the download data into its local memory. Once the IP 
Downloader communicates with the IP Attendant service it will transfer its stored PIPE 
data. 
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Troubleshooting the IP Downloader 

A remote user can verify that the IP Downloader is operating normally by opening the 
IP Downloader’s Home page and reviewing the Diagnostic and Activity Logs. 

 

1. From your web browser, open the IP Downloader’s home page. 

2. The Status line should say ―Running‖. 
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3. If the status is ―Communication Fault‖, confirm the following: 

 IP Attendant service is running (see page 23). 

 IP Downloader has the correct Server Host Name and port number (Click 
Manage Downloader and enter ‖password‖ when prompted for the 
password.) 

 IP Downloader and the IP Attendant have the same passphrase. 

 You can ping the Server Host Name. 

4. If all of the above are correct, go to the following for additional information: 

 Click Diagnostic to view the Diagnostic log. 

 Under the section Memory Details, look at the ―PIPE Downloads stored‖ 
field to see if any downloads are still in the downloader’s memory waiting 
to be downloaded. 

 Click Activity Log to see which PIPEs have been downloaded at this IP 
Downloader. 

Setting the Time Zone on the IP Downloader and PIPE 

The PIPE’s time is reset by the IP Downloader after each successful download to the 
IP Downloader. The factory default time zone is Greenwich Mean Time (GMT).  

To set the time zone on the IP Downloader: 

1. From your web browser, go to the IP Downloader’s home page. See the table 
on page 15 for the address. 

2. On the left side of the home page, click Manage Downloader and enter the 
password (the default password is ―password‖). Click Log In. 

3. Locate the Time Zone field under the Configuration section. 

4. Select the appropriate time zone for this IP Downloader. 

5. Click Apply to save the changes. 
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Updating the IP Downloader Firmware 

If new firmware becomes available for the IP Downloader, follow these steps to upload 
new firmware to your IP Downloader.  

1. From your web browser, go to the IP Downloader’s home page. 

2. On the left side of the home page, click Manage Downloader and enter the 
password (the default password is ―password‖). Click Log In. 

3. Locate the Firmware File to Upload field under the Firmware Update 
section. 

4. Browse to the .bin file that you received from TimeKeeping Systems. 

5. Click Upload Firmware to load this firmware into your IP Downloader. 

6. The Upload process goes through three phases: uploading, programming 
and verifying.  

7. Once verifying has finished, the following message appears in your web 
browser: 

 

  

 

8. Wait until the IP Downloader has restarted successfully — as indicated by 
solid green System and Network LEDs — and click Return to IP 
Downloader Home. 
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Using the IP Attendant 
 

How to verify the IP Attendant service is running 

The IP Attendant service starts automatically every time the computer is restarted. The 
owner of this service is the local SYSTEM account.  

To verify that the IP Attendant service is running, follow these steps: 
 

1. Click Start, then Programs. 

2. Click Administrative Tools, then Services. 

3. From the Services window, locate the Tks IPAttendant service name and 
confirm that the service is Started and the Startup type is Automatic as 
shown in the figure below. 

 

 

 

4. To start the service, highlight the Tks IPAttendant service, right-click and 
then click Start. 

5. To change the Startup Type, highlight Tks IPAttendant service, right-click 
and then click Properties. 

6. From the Properties window, change the Startup type to Automatic and click 
OK. 
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How to view the IP Attendant event log 

Each time a download file is processed by the IP Attendant, an entry is made in the 
event log. To open and filter the Event Viewer, follow these steps: 

 

1. Click Start, Programs and then click Administrative Tools. 

2. Double-click Event Viewer.  

3. The Application, Security, and System logs are displayed in the Event Viewer 
window.  

4. Click IP Attendant. 
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5. To view the details on any event, double click the event. 

 

 

 

6. On the View menu, click Filter. 

7. Click the Filter tab (if it is not already selected).  

8. Specify the filter options that you want and click OK.  

9. Only events that match your filter criteria are displayed in the details pane.  

10. To return the view to display all log entries, click Filter on the View menu, 
and then click Restore Defaults.  
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How to modify the IP Attendant configuration 

After the IP Attendant is installed, you may need to change its port number, logging 
activity, or passphrase. 

To change the IP Attendant’s configuration: 
 

1. Confirm that you are logged in as the Local Administrator or that your user 
account is a member of the Local Administrator group. 

2. Double-click My Computer and navigate to C:\Program 
Files\TimeKeeping Systems\IP Attendant. 

3. Double-click the Tks.IPAttendant.Wizard.exe file to start the IP Attendant 
Wizard. 

4. Follow the instructions in the wizard to change the configuration settings for 
the IP Attendant. 
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Troubleshooting the IP Downloader and IP Attendant 
 

Retrieving Status Information from the IP Downloader 

There are five status LEDs on the front of the IP Downloader. You can view the current 
status of these five LEDs from the IP Downloader’s home page by clicking Refresh Page.  

Refer to the following tables for status indicators and resolutions. 

 

Battery 

LED Status Indication  Resolution 

Light out No PIPE present Normal operation 

Solid green PIPE Battery OK Normal operation 

Solid yellow PIPE Battery low  

Contact TimeKeeping Systems technical 
support (support@thepipe.com)  

 

Solid Red PIPE Battery very 
low 

Blinking Red IP Downloader  
Battery low 

  

mailto:support@thepipe.com
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System Communication 

LED Status Indication  Resolution 

Solid green Last system 
communication 
successful 

Normal operation 

Solid yellow Communication in 
progress 

Normal operation 

Solid red Last system 
communication failed 

 From the IP Downloader’s home page, confirm 
that the server’s name and port number are 
correct 

 Verify that the IP Attendant service is running 

 View the event logs for the IP Attendant 

 Verify that the same passphrase is used at 
both the IP Attendant and the IP Downloader 

 Verify that the Internet and/or Windows 
Firewall settings are configured to receive on 
default port 50150 or a custom port number 
(rerun the IP Attendant Wizard to reset the 
ports: C:\ProgramFiles\TimeKeepingSystems\ 
IPAttendant\Tks.IPAttendant.Wizard.exe) 

Blinking Red No connection to 
system 

 From the IP Downloader’s home page, confirm 
that the server’s name and port number are 
correct 

 Verify that the IP Attendant service is running 

 View the event logs for the IP Attendant 

 Verify that the same passphrase is used at 
both the IP Attendant and the IP Downloader 

 

Network Connection 

LED Status Indication  Resolution 

Solid green Connected to 
network 

Normal operation 

Solid yellow Cable not 
connected 

Confirm that the internet cable is securely 
attached 

Confirm that it is an active connection 

Solid red Network error Confirm that you have a good network 
connection by pinging the downloader 

Blinking red Network not 
detected 

Confirm that you have a good network 
connection by pinging the downloader 
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Downloader Memory 

LED Status Indication  Resolution 

Light out Memory is empty Normal operation 

Solid green Memory contains 
data 

Normal operation 

Solid yellow Memory is over 
95% full 

 

Download the IP Downloader 

Solid red Memory full 

Blinking red Download failed – 
memory full 

Download the IP downloader. After the 
downloader’s memory is cleared, re-insert the 

PIPE into the IP downloader to download 

 

Download Status 

LED Status Indication  Resolution 

Light out No PIPE present Normal operation 

Solid green Transfer successful Normal operation 

Solid yellow Download in 
progress 

Normal operation 

Solid red Download error Remove the PIPE and re-insert the PIPE into 
the IP Downloader 

If the error persists, contact TimeKeeping 
Systems technical support 

Blinking red System Clock 
invalid 

Connect the IP Downloader to its 
LAN/WAN/Internet port so that it can 
communicate with the IP Attendant 
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How to determine your Computer Name 

For Windows XP and Server 2003 operating systems: 

1. Click (open) Windows Start menu, right click   ―My Computer‖ and select 
Properties from the popup menu. The System Properties dialog will appear. 

2. Select the‖Computer Name‖ tab. 

 

For Windows Vista and Windows 7 operating system: 

1. Click (open) Windows Start menu, right click on ―Computer‖ and select 
Properties from the popup menu. The System Properties dialog will appear. 

 

Confirming your Windows firewall settings 

Your workstation’s firewall settings are managed either at the workstation or per group 
policy. If your workstation’s firewall settings are managed by group policy or no 
exceptions are allowed, you must contact your network administrator to open port 
50150 (TCP) for the Tks IPAttendant service. 

To confirm that the Windows Firewall is configured to receive from port 50150 for the 
Tks IPAttendant service: 

1. Click Start, Settings, and Control Panel. 

2. Click Windows Firewall and navigate to the General  tab.  

3. Confirm that ‖Don’t allow exceptions‖ is not checked.  

4. Click the Exceptions tab and select the Tks IPAttendant. 
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5. Click Edit.  

 

 

6. If you want to limit access to the IP Attendant to certain computers, click 
Change scope.  
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7. Enter the IP addresses of the IP Downloaders that can communicate with 
this IP Attendant service and click OK.  

 

 

 

 

 

 

 

 

 

 

 

 



 31  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ED-99-0045-003 


